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            About "Sure Cuts A Lot 2" Thank you for choosing "Sure Cuts A Lot 2". "Sure Cuts A Lot 2" is an extremely easy program to cut your True Type fonts and various shapes using your Cricut TM Machine. With the combination of using your Fonts and importing custom artwork (SVG), the possibilities are endless! * "Cricut" is a registered trademark of Provo Craft & Novelty Inc. Craft Edge and "Sure Cuts A Lot" are not affiliated with Provo Craft & Novelty Inc. Features Works with your installed True Type fonts on your computer Works with Cricut Personal, Cricut Expression, and Cricut Create machines TM Works with thousands of free True Type fonts Works with hundreds of free True Type Dingbat fonts Import SVG files to allow you to use your own custom artwork Weld overlapping letters and shapes together Select styles, including Shadow and Blackout, to change the look of your letters and shapes No special cartridges required Cut additional shapes from the "Sure Cuts A Lot" Library WYSIWYG Interface - What you see is what you cut Available for Windows and Macintosh OSX Save your design layouts, so you can save your work to allow you to make changes over time System Requirements Macintosh Intel based Macintosh or greater Macintosh OS 10.4/10.5/10.6 512 MB of RAM 50 MB of available hard disk space USB Port 1.1 or 2.x Cricut TM Personal - Firmware v1.1 or 1.3 ( How to check/update your firmware version ) Cricut TM Expression - Firmware v2.1 or 2.3 ( How to check/update your firmware version ) Cricut TM Create - Firmware v1.51 ( How to check/update your firmware version ) Windows Pentium processor-based PC or compatible computer Windows XP/Vista/7 512 MB of RAM 50 MB of available hard disk space USB Port 1.1 or 2.x Cricut TM Personal - Firmware v1.1 ( How to check/update your firmware version ) Cricut TM Expression - Firmware v2.1 ( How to check/update your firmware version ) Cricut TM Create - Firmware v1.51 ( How to check/update your firmware version ) USB Serial Converter Driver ( How to download/install USB Driver ) 
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About "Sure Cuts A Lot 2"
 Thank you for choosing "Sure Cuts A Lot 2". "Sure Cuts A Lot 2" is an extremely easy program to cut your True Typefonts and various shapes using your CricutTM Machine. With the combination of using your Fonts and importingcustom artwork (SVG), the possibilities are endless!
 * "Cricut" is a registered trademark of Provo Craft & Novelty Inc. Craft Edge and "Sure Cuts A Lot" are not affiliatedwith Provo Craft & Novelty Inc.
 Features
 Works with your installed True Type fonts on your computerWorks with Cricut Personal, Cricut Expression, and Cricut Create machinesTM
 Works with thousands of free True Type fontsWorks with hundreds of free True Type Dingbat fontsImport SVG files to allow you to use your own custom artworkWeld overlapping letters and shapes togetherSelect styles, including Shadow and Blackout, to change the look of your letters and shapesNo special cartridges requiredCut additional shapes from the "Sure Cuts A Lot" LibraryWYSIWYG Interface - What you see is what you cutAvailable for Windows and Macintosh OSXSave your design layouts, so you can save your work to allow you to make changes over time
 System Requirements
 Macintosh
 Intel based Macintosh or greaterMacintosh OS 10.4/10.5/10.6512 MB of RAM50 MB of available hard disk spaceUSB Port 1.1 or 2.xCricutTM Personal - Firmware v1.1 or 1.3 (How to check/update your firmware version)CricutTM Expression - Firmware v2.1 or 2.3 (How to check/update your firmware version)CricutTM Create - Firmware v1.51 (How to check/update your firmware version)
 Windows
 Pentium processor-based PC or compatible computerWindows XP/Vista/7512 MB of RAM50 MB of available hard disk spaceUSB Port 1.1 or 2.xCricutTM Personal - Firmware v1.1 (How to check/update your firmware version)CricutTM Expression - Firmware v2.1 (How to check/update your firmware version)CricutTM Create - Firmware v1.51 (How to check/update your firmware version)USB Serial Converter Driver (How to download/install USB Driver )
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Download and Install
 The latest version of "Sure Cuts A Lot" can be downloaded at http://www.craftedge.com/download. After downloadingand installing the software, it will run in Trial Mode.
 When you launch "Sure Cuts A Lot", you will be presented with a window to Activate or Purchase the full version, orcontinue to use as the Trial version.
 The Trial Version will run exactly as the Full Licensed Version, except that when it cuts with the CricutTM machine, itwill add a DEMO watermark by cutting horizontal lines through your design.
 The Full Licensed Version will not cut any DEMO watermark cuts. You will need to purchase a license athttp://www.craftedge.com/purchase. Please see the Activate License Version section for information on activating theFull Licensed Version.
 http://www.craftedge.com/download
 http://www.craftedge.com/purchase
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Download and Install driver for Windows
 In order for "Sure Cuts A Lot" to work on a Windows machine, you will need to have the correct driver installed.
 How to install the driver for Windows?
 1. Connect your CricutTM machine to your computer and turn the CricutTM machine on
 2. If you do not have the driver installed, Windows will indicate that is has "Found New Hardware", and shouldprompt you to install a driver. If you do not get this, the driver may already be installed on your computer, and youshould see the entries in your "Device Manager" as in the screen shot at the bottom of this page.
 3. Choose the option to "Locate and install driver software".
 4. Choose the option to allow Windows to search for the driver online
 5. Windows should be able to find, download and install the correct driver
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6. If the driver was not found, you can download them here
 Once the driver has been installed (or if you already have the driver installed), you should see any entry for "USBSerial Converter" in your "Device Manager" under the "Universal Serial Bus controllers"
 http://www.craftedge.com/bin/CDM_2.02.04_WHQL_Certified.zip
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Activate Licensed Version
 To activate the Full Licensed Version, you must first purchase a license at http://www.craftedge.com/purchase. The computer you activate the software on does not require an Internet connection. However the activation processwill be easier from a computer that has an Internet connection.
 To activate the licensed version, please do the following (Method requires an Internet connection)
 Download, install and launch "Sure Cuts A Lot" (You can download the latest version athttp://www.craftedge.com/download)Click the "Activate" button or choose "Activate" from the "Help" menu.Enter your name and serial number in the appropriate fields.Click OK and the software will attempt to connect to our servers to activate your software on your computer.
 If you get an error saying the information is invalid, please note the following:
 Everything is case sensitive.The name must match exactly how it appears in your confirmation email (if you purchased from our web site)We recommend you copy and paste your serial number to avoid any confusion between certain letters andnumbers.Make sure you don't have any firewall/security software blocking "Sure Cuts A Lot" from connecting to theInternet.If you do not have an Internet connection, you will need to generate your Activation Code on a computer thathas Internet access, by following the directions below.
 http://www.craftedge.com/purchase
 http://www.craftedge.com/download
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The following are steps to manually generate your Activation Code.
 Download, install and launch "Sure Cuts A Lot" (You can download the latest version athttp://www.craftedge.com/download)Click the "Activate" button or choose "Activate" from the "Help" menu.Enter your name and serial number in the appropriate fields.Check the "Activate manually" checkbox. Once checked, you should see the Site Code and Activation Codefields appear.The Site Code field will already be pre-filled in, and cannot be changed.Visit http://www.craftedge.com/activation/surecutsalot.Enter your name, serial and site code.Click the "Generate Activation Code" button, and the Activation Code field should show your activation code.Copy and paste the activation code back into the program's activation dialog box and hit ok.
 If you get an error saying the information is invalid, please note the following:
 Everything is case sensitive.The name must match exactly how it appears in your confirmation email (if you purchased from our web site)We recommend you copy and paste values to avoid any confusion between certain letters and numbers.
 http://www.craftedge.com/download
 http://www.craftedge.com/activation/surecutsalot/
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Connecting Cricut Machine to your Computer
 You will need to connect your CricutTM machine to your computer via the USB port on the CricutTM machine and yourcomputer.
 Locate the USB port on the back of your CricutTM machine (next to the A/C adapter port) and plug in thecorresponding shaped end of your USB cable. Then connect the other end of the USB cable to an open USB port onyour computer.
 The CricutTM machine can be connected with any standard USB cable, as long as it is an A/B type cable. An A/B typecable has one flat end and one square end. The A/A type, with 2 flat ends, will not work.
 It is recommended you connect your Cricut machine directly to your computer and not through a USB hub or anotherdevice such as your monitor or keyboard.
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Cricut Firmware
 To be able to use "Sure Cuts A Lot" with your Cricut Machine, your Cricut machine must have the following firmwareversion:
 Cricut Personal - v1.1, 1.3Cricut Expression - v2.1, 2.3Cricut Create - v1.51
 To find the firmware version currently on your Cricut Machine, turn your Cricut machine on and it should immediatelyindicate in the display on your Cricut machine, which version you currently have.
 If you do not have the required firmware version, you will need to update the firmware on your Cricut Machine.Currently the only way to do this is through ProvoCraft's Cricut Design Studio software. There is a Trial versionavailable for Windows (XP SP2/Vista ) (If you have a Macintosh and need to update your firmware, you must do itfrom a Windows machine), which you can install for free and update the firmware on your Cricut machine.
 The following are steps to update your firmware using the Cricut Design Studio software.1. Connect your Cricut machine to your computer. Make sure it is connected directly and not through a USB hub. 2. It is recommended you disable any anti-virus software before doing the firmware update.3. Start the Cricut Design Studio software4. Make sure your Cricut machine is turned OFF.5. Put your Cricut machine into Firmware update mode, by press and hold down the Stop button, and then press thePower button. You must keep the Stop button pressed down until the Cricut machine beeps at you (usually in about 5seconds). At this point, your Cricut machine is now ready to receive the update.6. Choose "Update Firmware" from the Help menu. The update can take anywhere from 5 to 10 minutes. If the processfinished significantly faster than 5 minutes, the update most likely failed, and you will need to start the process againfrom the beginning.
 http://www.cricut.com/cds/
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Cutting Mat
 "Sure Cuts A Lot" allows you to create your designs using an on-screen virtual cutting mat as your workspace. The on-screen cutting mat can be set to be 6"x12", 12"x12",or 12"x24". (Note that 12"x12" and 12"x24" will only work withCricut ExpressionTM machines). You can change the size of your mat by choosing the "Mat Size" from the "Cutter"menu, or by choosing the Mat Size in the Document properties pane.
 The on-screen mat will prove to be very powerful and useful, as you can visually see all of the shapes laid out on themat, before cutting anything. Once you have everything laid out the way you want, simply choose "Cut Design" fromthe "Cutter" menu or click the Scissor toolbar button, and the CricutTM machine will start cutting your entire design.
 The on-screen virtual cutting mat allows you to adjust the properties of each shape laid out on the mat. Simply select ashape on the mat with the Selection Tool and it will be hilited with 8 blue circular selection handles. These handles willallow you to set the position, size and angle of the shape, just by click and dragging one of the handles.
 Free Move - The handle on the top-left corner of the selection box is used to move your selection anywhere onthe mat.Vertical Move - The handle in the top-middle of the selection box is used to move your selection up or down onthe mat.Horizontal Move - The handle in the middle-left of the selection box is used to move your selection left or righton the mat.Stretch - The handle in the bottom-left corner of the selection box is used to scale/resize the shape. While scalingwith this handle, the shape will retain it's proportions.Stretch Vertical - The handle in the bottom-middle of the selection box is used to scale/resize the height of theshape.Stretch Horizontal - The handle in the middle-right of the selection box is used to scale/resize the width of theshape.Rotate - The handle on either the top-right corner of the bottom-left corner of the selection box is used to rotatethe shape to the desired angle. If the Rotate type in the Properties window is set to "Skew", the top-right andbottom-left corner handles will allow you to rotate along a separate axis.
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Cut With CricutTM
 To begin cutting your design, either choose "Cut Design" from the "Cutter" menu, or click the Scissor toolbar buttonabove the mat.
 Before cutting, make sure you do the following first:
 1. Your Cricut machine is connected to your computer2. Your Cricut machine is turned on3. Your Cricut machine has the correct firmware version4. Paper is currently loaded in your Cricut machine. In order to load the mat/paper into the Cricut machine, you
 must have a cartridge inserted. It does not matter which cartridge is used.
 Choosing your Cricut machine When you choose to cut your design, you will be prompted to choose the type of Cricut machine you are using and thefirmware version that is on your Cricut machine. If you do not choose the correct model and firmware, your designmay not cut correctly, or at all.
 Important: If you chose the wrong model or version and you attempted to cut unsuccessfully, we recommend youreset your Cricut by turning it off and then back on, before trying to cut again.
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Getting Started
 Below is a brief description and steps to get started with "Sure Cuts A Lot 2".
 Starting "Sure Cuts A Lot 2" After launching "Sure Cuts A Lot", you will be presented with the an on-screen virtual cutting mat. This is where youwill add shapes to be cut with your CricutTM machine. For more information on using the on-screen mat, please see the"On Screen Virtual Mat" Section.
 Adding Characters to the Mat To add characters to the mat, you can choose one of the Type Tools from the Tools Panel to type text on the mat.You can also use the Keyboard Panel to click on the characters you wish to add to the mat.
 Note: If you are typing, but nothing shows up on the mat, the on screen mat may not have current focus, so clicksomewhere on the main window/mat to give it focus and start typing again.
 Adding Shapes to the Mat To add shapes to the mat, click on the shapes shown in the Shapes Panel. Shapes will be added to the center of thevisible area of the mat.
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Changing The Properties of the Placed Objects Once the objects are added to the mat, you can modify the placement, size and rotation in 2 ways. 1. Choose the Selection Tool from the Tools Panel and you can click on the objects on the mat to select them. Onceselected, they will then be hilited and will show 8 blue circular handles which can be used to move, resize and changethe angle of the selected object.
 2. Once an object is selected, the Properties panel will show attributes, such as position and size, which you canchange. You can type in new values and hit the Enter/Tab key to apply the new values, and the on screen mat shouldreflect the new changes.
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Preview Your DesignBefore cutting your design, you can choose to do a preview to see what outlines will get cut. To do a Preview, choose
 "Preview" from the "Cutter" menu or the Magnifying Glass toolbar button . The on screen mat will be redrawnwith outlines where the actual cuts will be made. This is useful when "welding" shapes together to see what will getcut. For more information on welding, please see the "Welding" section.
 Cutting Your Design With Cricut When you are ready to cut your design, choose "Cut Design " from the "Cutter" menu or the Scissor toolbar button
 . This will send your design to the Cricut machine for cutting. For more information on cutting, please see the"Cutting With Cricut" section.
 Saving your Design Layout You can save your project at any time by choosing "Save" or "Save As..." from the "File" menu, or by clicking the"Save" toolbar button. This will allow you to save the settings for your design, so you can open it again at a later timefor further modifications or for cutting with your Cricut machine. The saved project files, will have the file extension(.scut).
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Workspace
 You create and manipulate your designs using various windows and panels. Any arrangement of these windows andpanels is called a workspace.
 "Sure Cuts A Lot 2" has two predefined workspaces (Basic and Advance) which you can choose from the "Window ->Workspace" menu. You also have the option to save your own custom workspace.
 Workspace Overview Below is a screen shot of the "Advanced" workspace. The "Basic" workspace is the same, but has the "Layers" panelhidden.
 1. The main window where the on-screen virtual mat can be seen. Here you will be able to visually see and manipulateobjects added to your design layout.
 2. Tools Panel: select tools to create, select and manipulate objects on the mat.
 3. Properties Panel: change settings for objects, text and the mat
 4. Keyboard Panel: can be used for adding characters from fonts to the mat
 5. Shapes Panel: for adding shapes from the shapes libraries in "Sure Cuts A Lot 2"
 6. Layers Panel: organize objects in your design layout.
 Saving WorkspacesIf you want to arrange your windows and panels to your own liking, you can save the layout to your own customworkspace. Go to the "Window" menu and under the "Workspace" submenu , you can choose "Save Workspace".You will be prompted to choose a name for your workspace and it will be added to the "Workspace" submenu.
 Manage WorkspacesIf you want to delete or rename a workspace, you can choose "Manage Workspaces" under the Window ->
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Workspace menu.
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Creating Text
 Text can be added by either using one of the Type Tools from the Tools Panel, or by choosing characters in theKeyboard Window.
 Type ToolYou can add, edit and delete text by using on of the Type Tools from the Tools Panel.:
 Select a Type tool . The pointer will change to an I-beam cursor.Click on the mat where you want the text to be added.Type the characters you want to addWhen finished entering text, you can click elsewhere on the mat to start a new line of text, or choose theSelection Tool from the Tools Panel to select the text for moving, scaling, and rotating.
 Keyboard WindowThe Keyboard window will show the available characters for the chosen font. To add characters from the Keyboardwindow, you click on the desired character and it will automatically be added to the on-screen virtual mat.
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Changing Fonts
 Fon can choose a font to use from the Text Section in the Properties window.
 To be able to choose a font, you need to select the Type Tool from the Tools panel window and the Propertieswindow will show the Text options. If you already have text on the mat, you can use the Selection Tool to selectthe text and the Properties window will show the Text options
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Welding
 Welding allows you to make overlapping shapes to become a single shape, by joining shapes together wherever anoverlap occurs. To enable welding, you need to check the "Weld" option in the Appearance Properties Section for theobjects you wish to weld.
 Below is an example of how to Weld.
 1. First we will add the word "Craft" to the mat
 2. Originally nothing overlaps, so we will move the letters so that they overlap each other. Select the entire word andenable the "Weld" option in the Appearance Properties Section.
 3. Now if we do a "Preview" by choosing "Preview" from the "Cutter" menu or choosing the Magnifying Glass toolbarbutton, you should see which outlines will be cut as indicated by the specified page color (in this case red outlines).You should notice the overlapping areas are removed and will not be cut now.
 4. Now we will weld the word "Edge" to our welded "Craft" word. So we type the word "Edge" and move it so itoverlaps the welded Craft word.
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5. If we now do a Preview, you should see the overlapping between the 2 words are not removed. This is because weneed to enable the "Weld" option for the new "Edge" word.
 6. If we select the "Edge" word on the mat and check the "Weld" option in the Properties window and now do aPreview, you should see the overlapping areas are now removed.
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Pages
 Pages represent virtual cutting mats. Each project can have multiple pages. This is useful if your overall design willhave multiple layers of paper, so you can layout your designs on multiple pages and preview the overall design.
 Each page can be assigned a name and color to help identify each page in your project.
 Add/Remove PagesYou can add pages by choosing "Add Page" from the "Page" menu in the main menu bar or in the menu button inthe page bar.
 To remove pages, you can choose "Delete Page" from the "Page" menu in the main menu bar or in the menu button in the page bar. You can also click the close button in the page tabs.
 Page Order The page tabs show the order of the pages, where the left-most page is on top and the right-most page is at the bottom.You can change the order by dragging the page tabs to a new location in the page order. To move a page, click andhold the mouse button in the page tab you wish to move. Then drag (left or right) and release the mouse button at thenew location. When dragging, you will see a vertical line indicating where the page will be inserted.
 Previewing PagesYou can do a preview to see what is going to get cut when you decide to cut your design with your Cricut. You havethe option to preview the current page or you can also preview all the pages in the design.
 To preview the current page, choose "Preview" from the Cutter menu or click the Preview toolbar button . Youwill see the lines that are to be cut outlines in the specified color of the page being previewed.
 To preview all the pages in your project, choose "Preview All" from the "Cutter" menu or click the Preview All
 toolbar button . This will fill in the objects to be cut with the specified color of the pages being previewed. Pleasenote that this may not represent the actual lines that will be cut. To see the actual cut lines, you should do the regular"Preview" and not "Preview All".
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Selecting And Arranging Objects
 "Sure Cuts A Lot" allows you to select and position objects. You can also group objects so that they are treated assingle object, and selectively lock or hide objects.
 Selecting ObjectsTo select an object you first need to select the Selection Tool from the Tools Panel. Then you can click on anobject on the on-screen virtual mat. If an object is selected, you will see blue circular handles around the objectallowing you to move, resize and rotate the selected object. You will also be able to change the properties for theselected object in the Properties Panel.
 To select multiple objects, you can click and drag the cursor over the objects you wish to select. The area will beshown as a dotted blue rectangle, where any objects that are within that area will be selected.
 You can also add additional objects to the current selection by holding down the Shift key and clicking on the objectsyou wish to add to the current selection.
 Grouping Objects You can combine several objects into a group so that the objects are treated as a single object. You can then move ortransform the objects within the group without affecting their attributes or relative positions.
 To group objects, use the Selection Tool to select the objects you wish to group. Then choose "Group" from the"Object" menu. You can un group groups by selecting the group and choosing "Ungroup" from the "Object" menu.
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Import SVG Files
 "Sure Cuts A Lot" allows you to import SVG files, giving you the power to cut your own custom artwork. SVG standsfor "Scalable Vector Graphics" and is a file format for describing vector graphics. There are numerous sites where youcan download .svg files. You can also create your own .svg files by using compatible software such as AdobeIllustrator or a free program called Inkscape.
 To import .svg files, choose "Import SVG.." from the "File" menu or clicking the "Import SVG" toolbar button . This will bring up a dialog to choose the svg files you wish to import.
 Please note that "Sure Cuts A Lot" will only import the vector artwork found in .svg files. It cannot import any text orRaster/Bitmap images embedded in a svg.
 If you want to cut our a Raster/Bitmap image (ie, jpeg, gif, bmp, png, etc..), you will need to convert it to vectorartwork by tracing the image, and saving it as a .svg using compatible software (Adobe Illustrator, Inkscape, etc.). Youcan also use the built-it auto tracing feature by choosing "Trace Image.." from the "File" menu or clicking the"Trace Image" toolbar button. For more information on using the auto trace feature, see the Trace Image Section.
 http://www.adobe.com/
 http://www.adobe.com/
 http://www.inkscape.org/
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Trace Image Files
 "Sure Cuts A Lot" allows you to import image files (.bmp, .jpeg, .gif, .png) and will attempt to automatically trace theimage for cutting. Please note, results may vary depending on the source image file.
 Autotrace Image
 Choose "Trace Image" from the File menu or click the "Trace Image" toolbar button . This will bring up theAutotrace window.
 Choose An ImageClick the "Browse.." button to choose an image file you would like to trace. The program can accept most .bmp, .gif,.jpg and .png files. If you have Apple Quicktime installed, it can import additional image formats that are supported inQuicktime.
 Autotrace SettingsYou can adjust the settings for the tracing in the Settings area.
 Brightness: adjusts the brightness of the source image to help the autotracer distinguish what should be traced.Corner: corner threshold determines how it should handle corners found.Despeckle: removes tiny shapes of up to this size to help clean up the source imageOptimize: curve optimization. This can help reduce the number of nodes/points
 Please note that results may vary depending on the contents of the source image file. It will work best for solid filledobjects over a white background.
 Output
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Preview: Allows you to see the resulting tracing of the image with the specified settingsSave: Allows you to save the output to a SVG fileOK: This will add the resulting trace to the virtual mat
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Keyboard Panel
 The Keyboard Panel allows you to quickly see the available characters for a chosen font and add them to the onscreenvirtual mat.
 Adding Characters To The MatTo add one of the characters to the mat, you can use the mouse cursor to click on desired character and it willautomatically be added to the onscreen virtual mat.
 You can also add characters by using the Type Tool from the Tools Panel .
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Shapes Panel
 The Shapes Panel allows you to choose additional pre-made shapes to add to the on-screen virtual mat for cutting.
 Select A Shape Library You can choose a library from the "Shapes" drop down menu. Once selected, the available shapes in that library willappear below.
 Add A Shape To The Mat To add a shape from the Library to the onscreen virtual mat, you can do one of the following:
 Click on the desired shape. This will automatically add the shape to the center of the visible on-screen mat area.Click and hold down the mouse button, to drag the shape to the desired location on the mat and then release themouse button to place the shape.
 Organizing Shape Libraries From the "View" drop down menu, you can choose how to view the list of available shape libraries.
 All: shows all of the available shape librariesFavorites: shows the list of shape libraries that you tagged as a favorite. You can add/remove a shape library
 from the favorites list by clicking the Add/Remove Favorite button Project: shows the list of shape libraries that are being used in your current design project
 Adding Additional Shape Libraries "Sure Cuts A Lot" comes with a few shape library files. You can also add additional shape library files to the programas well. We offer another program called "Lib It Up" which can be used to package SVG files into a shape library file(.lcut)
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Properties Panel
 The Properties Panel allows you to change the settings for the virtual mat and any objects placed on the mat. Thiswindow will show different settings that can be changed depending on what tool is currently selected from the Toolspanel and what is currently selected on the onscreen virtual mat.
 Show/Hide Property SettingsYou can hide/show sections within the Properties Panel by clicking in the blue title bar of the section you wish tohide/show. In the example shown below, we have clicked in the title bar area, labeled "Document", to hide the settingsfor the Document. If you wish to un hide the settings, simply click in the blue title bar area to show the settings again.
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Property SectionsDifferent settings will appear depending on what tool is currently selected from the Tools panel and what is currentlyselected on the virtual mat.
 Document - Change the view settings for the mat (mat size, measurement units, zoom level, etc.)Page - Change the settings for the current page (name, color)Position & Size - Change the position and size of the objects on the matAppearance - Change how the objects on the mat will look (normal, shadow, blackout)Text - Change settings for text added to the mat (font, size, spacing)
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Document Settings
 The Document settings allows you to change settings for the onscreen virtual mat.
 These settings can be seen when you have the Selection Tool selected and no objects are currently selected on the mat.If you have objects selected, you can click anywhere on the mat where there are no objects to deselect the selectionand the Properties panel should then show the Document settings.
 Mat Size: Choose the size of your mat. This will correspond to the physical size of the cutting mat you will be using inthe Cricut machine.
 Units: Choose the unit of measurement to use for manipulating objects on the mat.
 Zoom: Choose the zoom level to zoom in or out. You can also zoom in/out using the Zoom Tools from the ToolsPanel.
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Page Settings
 The Page settings allows you to change settings for the current page. For more information on pages, see the Pagessection.
 These settings can be seen when you have the Selection Tool selected and no objects are currently selected on the mat.If you have objects selected, you can click anywhere on the mat where there are no objects to deselect the selectionand the Properties panel should then show the Page settings.
 Name: Enter the name for the page and then hit the Enter key to apply the name.
 Color: Click to change the color of the page. The color chosen is for design purposes only and is the color that is usedwhen you do a preview.
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Position & Size Settings
 The Position & Size settings allows you to change the position and size of objects on the mat.
 X: The horizontal position of the object.Y: The vertical position of the object.
 Nudge: Slightly shift the object Left, Right, Up or Down on the mat.
 W: The width of the object.H: The height of the object.
 Keep Proportions: If checked, it will keep the current aspect ratio of the object when resizing it.
 Rotate: This will determine how the object will be rotated. If you choose "Rotate" it will rotate the shape normally. Ifyou choose "Skew" it can be rotated separately along the X and Y axis when using the rotate handles around the shapeon the mat.
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Appearance Settings
 The Appearance settings allows you to change the appearance of objects placed on the mat.
 Style: Choose how you wish the objects to appear.
 Normal: Original look
 Shadow: Expands the outlines
 Blackout: Removes interior outlines
 Shadow Blackout: Combination of both theShadow and Blackout styles
 Flip: Flip the objects horizontally or vertically.
 Flip Horizontally: Flips the selectedobject along the Y axis
 Flip Vertically: Flips the selected objectalong the X axis
 Weld: Check to enable welding to combine overlapping edges. For more information, please see the Welding section.
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Text Settings
 The Text settings allows you to change settings for adding or editing text on the mat..
 Font : This drop down list shows the available fonts to choose from. It will show the name of the font and a sample ofthe font on the right hand side. "Sure Cuts A Lot 2" can only use vector based fonts (TrueType) and not raster/bitmapbased fonts. The program will load the fonts that are loaded in your system. You do not add fonts directly to "SureCuts A Lot".
 Size: Enter the font size (height).
 Width: You can change the width of the individual characters. This is entered as a percentage relative to it's normalwidth.
 Tracking: You can change the tracking (spacing between the letters) of the individual characters. This is entered as apercentage relative to it's normal spacing.
 V Offset : You can change the vertical offset of the individual characters to raise or lower the character from the baseline of the text.
 Organizing Fonts From the "View" drop down menu, you can choose how to view the list of available fonts.
 All: shows all of the available fontsFavorites: shows the list of fonts that you tagged as a favorite. You can add/remove a font from the favorites list
 by clicking the Add/Remove Favorite button Project: shows the list of fonts that are being used in your current design project
 Adding Additional Fonts "Sure Cuts A Lot" loads the fonts that are installed in your system. Fonts can be downloaded from the internet andinstalled in your system via the Fonts control panel.
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Tools Panel
 The Tools panel, by default, appears at the left side of the screen. You use the tools in the Tools panel to create, selectand manipulate objects on the onscreen mat.
 Some tools have a small triangle at the lower-right corner of the tool icon, indicating there are additional hidden toolsbeneath it. To see the hidden tools, click and hold down the mouse button over the tool icon and the hidden tools willappear.
 Select A ToolYou can select a tool by doing one of the following:
 Click a tool in the Tools panel. If there is a small black triangle at the tool's lower right corner , you can holddown the mouse button to view the hidden tools, and then click the tool you want to select.Press the tool's keyboard shortcut key.
 Tool Keyboard ShortcutsSome tools can be selected by hitting the corresponding keyboard shortcut.
 Selection Tool: Ctrl keyType Tool: T keyHand Tool: Space Bar
 ToolsBelow is a overview of the available tools in Sure Cuts A Lot.
 Selection ToolThe selection tool is used to select objects on the mat. Once selected, you can move, scale, rotate the selected objects.
 Type Tool The type tool is for adding/editing characters on the mat.
 Vertical Type ToolThe vertical type tool adds characters vertically (from top to bottom)
 Zoom In ToolThe zoom in tool increases the view magnification of the mat.
 Zoom Out ToolThe zoom out tool decreases the view magnification of the mat.
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Hand ToolThe hand tool allows you to move the mat within the workspace window.
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Layers Panel
 The Layers panel is used for organizing objects in your design layout. By default every page contains one layer, andeach object added to the page is added to that layer. However, you can create new layers and rearrange objects asneeded.|
 VisibilityIndicates whether objects in the layer are visible or hidden. The visible icon indicates that the layer is visible. Ifobjects are hidden, they will not be visible in the Preview and will not be cut when cutting with the Cricut.
 LockIndicates whether objects in the layer are locked or unlocked. The lock icon indicates that the layer it locked andcannot be edited.
 ColorColor of the layer.This color will determine the display color for all objects added to the layer.To change the color, youcan choose "Layer Properties" from the "Layer" menu or double click on the layer to change in the Layers Panel.
 Name Name of the layer. You can name the layers to help identify each layer. To change the name, you can choose" LayerProperties" from the "Layer" menu or double click on the layer to change in the Layers Panel.
 Create A New LayerNew layers will be added above the current selected layer.To add a new layer, do one of the following
 Click the New Layer Button in the Layers panel.Choose New Layer from the Layers menu button in the Layers panel.Choose Insert Layer from the Layers menu from the main menu bar.
 Create A New Layer FolderLayer folder can be used to help organize/group layers together. New layer folders will be added above the currentselected layer.To add a new layer folder, do one of the following
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Click the New Layer Folder Button in the Layers panel.Choose New Layer Folder from the Layers menu button in the Layers panel.Choose Insert Layer Folder from the Layers menu from the main menu bar.
 Delete A LayerYou can delete the current selected layer by doing one of the following:
 Click the Delete Layer Button in the Layers panel.Choose Delete Layer from the Layers menu button in the Layers panel.Choose Delete Layer from the Layers menu from the main menu bar.
 Moving LayersThe order of the layers in the Layers panel determines the hierarchy of the objects on the page. Layers at the top willappear on top of layers beneath it. By creating multiple layers in your page, you can control how overlapping objectsare displayed.
 You can rearrange the order of the layers by dragging them within the Layers panel. You can only move a single layerat a time.To move a layer, click and hold the mouse button in the layer you wish to move. Then drag and release themuse button at the new location. When dragging, you will see a horizontal line indicating where the layer will beinserted.
 Lock/Unlock LayersLocking layers prevents you from selecting and editing them.
 Hide/Show LayersHiding layers prevents them from being displayed on the mat. Hidden layers/objects will not appear in the Preview andwill not be cut when cutting the page with the Cricut machine.
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Frequently Asked Questions
 Will this software work with my CricutTM machine?
 This software is compatible with both the original and current models of the original CricutTM , CricutExpressionTM and Cricut CreateTM machines. You may however need to update the firmware on your Cricutmachine for the software to function properly.
 What firmware version do I have and need?
 When you turn on your CricutTM machine, the display will show which firmware version is currently loaded onyour CricutTM machine. "Sure Cuts A Lot" requires version 1.1 or 1.3 for the original CricutTM machines andversion 2.1 or 2.3 for Cricut ExpressionTM machines and version 1.51 for Cricut CreateTM machines..
 How do I update my firmware?
 Right now, the only way to do this is from a Windows machine, by using ProvoCraft's Cricut Design StudioTM
 software. They have a free trial version available for download which you can download and use to update thefirmware on your Cricut machine.
 What operating systems can I run "Sure Cuts A Lot" on?
 We have versions available for Windows (XP/Vista/7) and Macintosh OSX (10.4/10.5/10.6)
 Can I cut the shapes from my CricutTM cartridges?
 No. "Sure Cuts A Lot" cannot cut any shapes from your Cricut cartridges.
 Do I need a special USB cable to connect my computer to my CricutTM machine?
 No. Any standard USB cable will work, as long as it is an A/B type cable. An A/B type cable has one flat end andone square end (A/B type of cable is usually the same as those used to connect a printer or external drive viaUSB). The A/A type, with two flat ends, will not work.
 Is Cricut Design StudioTM required for "Sure Cuts A Lot" to work?
 If your Cricut machine does not have the correct firmware version, you will need to use Cricut Design Studio toupdate the firmware on your Cricut machine before "Sure Cuts A Lot" can cut properly. There is a free trialversion available which can be used to update the firmware. Otherwise, "Sure Cuts A Lot" does not depend onCricut Design Studio to work.
 Can I install the software on a second computer?
 The license for our software is a single user license, and entitles that single user to install the software on a secondcomputer of the same platform for which the license was purchased for, provided they are not both used at thesame time, or by more than one person..
 Can I use my serial to install on both a Windows and Macintosh computer?
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No. The license keys are specific to the platform for which it was purchased for. You will need to purchase aseparate license for each platform you wish to use the software on..
 * Cricut, Cricut Expression, Cricut Create and Cricut Design Studio are trademarks of Provo Craft and Novelty Inc.Craft Edge and "Sure Cuts A Lot" are not affiliated with Provo Craft and Novelty Inc.
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Contact Us
 E-mail: [email protected]
 Web: http://www.craftedge.com/support
 Forums: http://forums.surecutsalot.com
 mailto:[email protected]
 http://www.craftedge.com/support
 http://forums.surecutsalot.com/
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